
Product Code: DPOCT304

Welcome to the Demon Internet Suite Trial Version
The Demon Internet Suite is set of easy-to-use Internet software for Windows.  This trial version
offers both a free edition of the software and the opportunity to try Demon's Internet service, 
with nothing to pay for 30 days.
____________________________________________________________________________

Note: If you are already using Turnpike, this is not an upgrade for your existing software.
____________________________________________________________________________

This 'Readme' explains how to get up and running on the Internet using this software.  It will 
help you through the process of installing and setting up Turnpike and Microsoft Internet 
Explorer.  You may wish to print this out for reference.

When you exit from this 'Readme' the Setup program will proceed with the installation.

The Turnpike Internet access software offers all the basic Internet functions: Email, News, FTP,
Telnet, Finger and Ping (and Traceroute), with Microsoft Internet Explorer for browsing the 
World Wide Web, and built-in 16-bit and 32-bit Winsocks.

The full Demon Internet Suite offers, in addition, a set of comprehensive user guides, a copy of 
SoftQuad's HoTMetaL v3 light for designing your own Web pages, a 60 day evaluation version 
of Cyber Patrol which is a leading Internet filtering package, and a copy of  Progressive 
Networks' RealAudio Player for receiving audio across the Internet.

The latter part of this 'Readme' describes some things you will want to do once Turnpike has 
been installed. A copy of this section will be installed with the program as a Readme.wri file, in 
case you wish to consult it in future - together with two other 'Readmes', Fyi28.wri and 
Readw95.doc.

New Users of the Internet are recommended to study the Fyi28.wri document, which explains 
the basic rules of 'Netiquette' (Network Etiquette) that all users should follow.

The Readw95.doc document offers advice for Windows 95 users on running Turnpike with the 
Windows 95 Dial Up Networking (DUN) software. The Readw95p.doc file on the CD contains 
the same advice, but with pictures.  These can be read using either Word 6 or the Windows 95 
WordPad. However, there's no need to use the Windows 95 DUN unless you particularly want 
to, as Turnpike provides its own Winsock which is easier to set up and use than the Windows 95
DUN.

This edition of the software is free for use with Demon Internet.  The software may also
be evaluated for 30 days from date of installation, for use with other Internet Service

Providers.
___________________________________________________________________________

Installation
This Setup program installs:

* The main Turnpike program which is used to read and prepare email messages and news 
articles, plus its companion Connect program which is used to dial up your Access Provider, 
to transfer mail and news, and to use 'on-line services'.

* Microsoft Internet Explorer which is used with Connect to 'browse' the World Wide Web.



* WS-FTP which is used with Connect to transfer files across the Internet.

* The NTS Winsock supplied with Turnpike, for Windows 3.x and for Windows 95.
(This is not suitable for Windows NT, and will not be installed.  On Windows NT you need to use the 
RAS with Turnpike.)

(and an 'Uninstall' program).

When you close this Readme, you will be asked whether you want a 'Typical', 'Compact' or a 
'Custom' installation. The 'Typical' installation installs all the above programs; the 'Compact' 
installation installs just Turnpike, Connect and the NTS Winsock, while the 'Custom' installation 
allows you to choose the precise combination of these items you want installed.

You should check that you have your modem attached to your PC, and turned on.  Then pick 
the type of installation you want and follow the instructions on the screen.

After the files have been copied to your disk, you will first be taken through an 'Initial Setup' 
Wizard, then a 'Modem Setup' Wizard, and last (if you have chosen it) an 'On-Line Registration' 
Wizard with which you can set up a new Demon account with 30 day FREE trial period.

At each step, if you have any queries, just click the Help button.

At the end of the procedure, you may need to restart your machine before you can start using 
Turnpike. You can veto this if you wish, but you are unlikely to be able to connect to the Internet
until your machine has been restarted.

Note: Turnpike works most easily with the NTS Winsock, but if you are already using the 
Microsoft Dial-Up Networking (DUN) on Windows 95 you may wish to continue using that.

Note: Where the NTS Winsock is not used, to access the On-Line Registration server at Demon
you need to set up the dialer to dial in as Host Name: olr, and Password: olr.  Once the account 
is set up you need to set up the dialer to dial in as your chosen Host Name and your chosen 
Password.

Note: The security features of Internet Explorer 3 are set to Microsoft's standard defaults. 
Among other things, this means that it is supplied with ActiveX and Java enabled. Depending on
the sites you plan to visit, you may wish to disable these. For guidance, call up Internet 
Explorer's on-screen Help and search for information on 'Security'.
___________________________________________________________________________

This part of the 'Readme' will be installed with the software.  If you now exit from this
'Readme' the Setup program will proceed with the installation.  You could read the rest of

this when the setup is complete.

Running Turnpike for the first time
After Installation has been completed, the first thing you need to do is pick up the list of 
newsgroups available to you. If there's any mail waiting for you, this will be collected at the 
same time.

To do this, you need to run the Connect program - for example by double-clicking on its icon.

Assuming you're using Turnpike to dial, Turnpike will then display its 'Connect' dialog for you to 
go ahead and connect to your Access Provider. Simply click the Connect button to do this. (If 
Turnpike isn't being used to dial, you will instead see a message about a 'Third-party Winsock'. 
Leave this message on the screen while you dial up using whatever software you've been using
to do this up to now, then promptly switch back to the Turnpike Connect program and allow it to 
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continue.)

Messages on the Status bar at the bottom of the display will then show Turnpike collecting news
(in this case, the list of newsgroups) and picking up any mail that's waiting for you.

Collecting the list of newsgroups takes a little while, so while this is going on we suggest you 
click the Ping button on the toolbar. This displays the Ping dialog ready set up to 'Ping' your 
Access Provider. Pinging provides a good way of checking that all is well, so we suggest you try
this.

When Turnpike tells you News connection closed, you can disconnect from your Access 
Provider (by clicking the Disconnect button) because Turnpike has now downloaded all the 
information it is going to. But don't leave Turnpike Connect until the separate News 
completed - xxxx articles fetched and filed message has appeared, signalling that Turnpike 
has finished filing this information.

What to do next
At this point, we suggest that you try out the main Turnpike program.

If Turnpike Connect is still running, you can run the main Turnpike program by clicking the 
Mail/News button on the toolbar. Alternatively, you can return to the Turnpike program group / 
folder and double-click on the Turnpike program icon.

When the program has loaded ...

* Read any mail that has arrived for you

If any mail has arrived for you, the 'Mailbox' icon at the bottom of the Turnpike display will be 
showing a little pile of papers in its top tray and flashing.

To see this mail, double-click on the Mailbox icon to go into your mailbox. The messages that 
have arrived will then be listed in the upper part of the mailbox display. To read a message, 
double-click on it to open it - then when you've finished reading it, close it and open another.  
You can use the space bar to open each unread message in turn, if you prefer.

Note: Each message actually starts with a 'Header' comprising several lines of administration 
information, but Turnpike normally limits what it displays to the subject, the author and the date. 
If you would like to see the full header on a message, take the Display Header option from the 
Options menu.

* Set up a 'newsstand' for your newsgroups

To do this, go to the File menu, select New... and then choose New newsstand.  This starts the
Newsstand Setup Wizard to guide you through creating a newsstand.  Select each newsgroup 
that interests you and then click the Add button.  You can use the Find slot to locate particular 
subjects -- for example, *music will find all newsgroups that include the word music in the 
newsgroup name.

It is best to try only a few newsgroups at first, otherwise download times may become rather 
long.  New users of the Internet are recommended to subscribe to the 
news.announce.newusers newsgroup, while demon.ip.support.turnpike (if this is available 
to you) is the newsgroup for discussion of Turnpike.  It is also a good idea to subscribe to any 
newsgroups provided for support and service announcements by your Access Provider.  For 
example, Demon customers should consider subscribing to demon.announce and, if new to 
the Internet, to demon.ip.support.newuser.
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After adding the newsgroups you want, click Next and fill in your details.  Click Next again and 
give the newstand a name of your choice.  When you click Finish, the newstand will be created 
for you.  The Wizard allows you to go back through these steps and, of course, you can click on 
the Help button if you wish further guidance.  It is easy to change any of the settings later by 
clicking the right mouse button on the newsstand and selecting Properties.

The Wizard will leave you with a view of the open newsstand, in which you will see the 
newsgroups you selected in the order in which you picked them out.  If you want to change this 
order, drag the newsgroups up or down the list with the mouse, or use the Move Up and Move 
Down buttons.

Articles from the newsgroups you selected will be collected the next time you use Turnpike 
Connect to connect to your Access Provider.

* Prepare any email messages you want to send

To prepare an email message, select your mailbox then click the Start new email button on the 
toolbar. (If you can't see your mailbox to select it, you can look in the Windows menu.)

This calls up Turnpike's Editor ready for you to write your message. Simply fill in the email 
address of the person you want to write to in the 'To' slot; fill in the subject in the 'Subject' slot; 
and type the text of your message in the section above the solid blue line drawn across the 
display. (Note: There's no need to type a carriage return at the end of each line because 
Turnpike will automatically insert the required line breaks for you. There's also no need to worry 
about the number of characters per line as the margins are automatically set to give the 
recommended maximum of 72 characters per line in the font you are using.)

What's shown below the solid blue line is a 'signature' based on your full name, which Turnpike 
has inserted for you. This is just text which you can change in any way you want simply by 
editing it. After arranging the signature you want, we recommend taking the Save signature as 
option from the Signature menu and saving this signature as standard.sig: then Turnpike will in
future insert this signature in your messages.

When you've finished preparing your message, click the Post button on the Editor toolbar and 
confirm that you want to post this message. The message is then put into your Out tray, from 
where it will be sent out across the Internet the next time you connect to your Access Provider.

Note: If, rather than send a new message, you want to send a reply to a message you've 
received, select it (or open it on the screen) and click the Reply button. This too takes you into 
Turnpike's Editor, but by taking the Reply option you automatically get the 'To' and 'Subject' slots
filled in with the appropriate information from the original message. You also get a properly 
marked up copy of the original message in your reply. Simply cut out any bits of the original 
message you don't want to quote, add what you want to say and then click the Post button to 
add this reply to the collection of messages in your Out tray.

Exploring the Web

To explore the World Wide Web from Turnpike, you need to run the Connect program, connect 
to your Access Provider and then click the WWW button on the Connect program toolbar to run 
Microsoft Internet Explorer. (The Connect program provides the connection to the Internet over 
which the Internet Explorer accesses the Web.)

This takes you to the 'Starting page'. This and other Web pages contain underlined items, which
are links to other Web pages or facilities. To call up any of these pages, simply click on the 
appropriate item - in the same way as you might call up different pages of information from a 
Help file. 
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The other way of calling up other pages is by entering the page's 'URL' in the Address slot at the
top of the display. (If this slot isn't shown, call up the View menu and select Address Bar.)

What's shown in this slot is the URL of the Web page you are looking at. To go to a different 
page, simply edit the URL that's currently shown and press [Enter]. For example, if you want to 
call up the Lycos Internet Catalog, you can do this by replacing the current URL by the Lycos 
Catalog page URL (http://www.lycos.com/) and pressing [Enter]. (This Lycos page is actually 
quite a useful one to call up because it allows you to access information on a whole range of 
different subjects.)

Each page you call up is automatically added to a 'History' which the Internet Explorer records 
to make it easy for you to go straight back to pages you called up earlier. Simply use the Arrow 
buttons at the top of the screen to go back and forth through these pages - or call up the File 
menu and pick the page you want from the lower part of this menu. (The More History option in
this menu calls up a display of all the pages you've visited, including in previous sessions.)

Note: Each new Web page you call up can take a little while to display, particularly where it 
contains a number of graphics. If there's apparently no response for 120 seconds, Turnpike will 
automatically display a message asking whether you want it to continue trying to contact the 
source of the information. The idea of this message is to save you running up expensive phone 
bills when the remote computer you are dealing with is too busy to service your request at a 
reasonable speed. If you feel that this message appears too often, then the next time you 
connect to your Access Provider, pause at the Connect dialog and set the 'Idle timeout' to a 
larger number of seconds - or disable the feature altogether by setting the Idle timeout to 0. 

Other Facilities

This introduction has only scratched the surface of the facilities Turnpike and Internet Explorer 
have to offer.

You can, for example, set up mailboxes for different types of mail; give yourself a range of email
names and signatures to use (and arrange that the appropriate ones are used by associating 
these with different mailboxes and newsstands); tag messages with their subject so that you 
can pull out all the correspondence you've exchanged on a particular subject etc. etc. There are
special features for News such as marking discussion threads 'interesting' if you want these 
drawn to your attention or 'uninteresting' if you don't, and 'Kill rules' to help you avoid cluttering 
up your disk with articles you don't want to read. There are also special features for shared 
systems that allow certain types of mail to be processed by any of a group of people.

Similarly, when you are connected to your Access Provider, there are additional facilities like 
Telnet, FTP, Finger and Traceroute and further features of Microsoft Internet Explorer to 
investigate.

The way to find out about all these features is from the on-screen Help. Either press F1 to call 
up the appropriate Help then click the Contents button to turn to its Contents page, or use the 
options offered in the Help menu. This will show you a list of the broad areas covered in the 
Help. Click on the area you are interested in to display a page of information on that, then work 
on through the information given. Alternatively, use the Index/Search option to call up pages on
particular topics or, if there are [>>] and [<<] buttons at the top of the display, you can use these 
to 'browse' through a series of pages on related topics.

Note: Turnpike, Connect and Microsoft Internet Explorer are separate programs and so have 
separate Help support. In particular, the Help file for the main Turnpike program covers 
Turnpike's 'Off-line' facilities, while the one for Turnpike Connect covers the 'On-line' facilities. 
The FTP facilities of Turnpike Connect also have their own Help file because these are provided
by a separate program.
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___________________________________________________________________________

At the end of the Trial period

If you are a Demon Subscriber

The Trial Version of the software will work indefinitely, at least for connecting to Demon.

We recommend upgrading to a full copy of The Demon Internet Suite -- so that you also have a 
set of comprehensive user guides, a copy of SoftQuad's HoTMetaL v3 light for designing your 
own Web pages, a 60 day evaluation version of Cyber Patrol which is a leading Internet 
filtering package, a copy of  Progressive Networks' RealAudio Player for receiving audio 
across the Internet, and support for other Access Providers.

For Demon subscribers, the Demon Internet Suite costs just £29.37 including VAT and Delivery, 
and can be ordered direct from Demon.

Either call Demon's Credit Card Line on 0181 371 1234, email sales@demon.net 
or send a cheque (with your cheque guarantee number and your Demon host name on the 
back) to:

Demon Internet Ltd (Windows software offer), 
Gateway House, 322 Regents Park Road, Finchley, London N3 2QQ.

Please allow 28 days for delivery.

(Note: Calls to 0181 371 1234 may be monitored for training purposes. This information may be used for marketing 
purposes.)

If you are not a Demon Subscriber

The software will expire after 30 days.

If you would like to continue using Turnpike, you will need to upgrade to a full copy of The 
Demon Internet Suite.  This includes a set of comprehensive user guides, a copy of SoftQuad's 
HoTMetaL v3 light for designing your own Web pages, a 60 day evaluation version of Cyber 
Patrol which is a leading Internet filtering package, and a copy of  Progressive Networks' 
RealAudio Player for receiving audio across the Internet.

To order, either: phone Turnpike Sales on 0345 666333
      or: print and fill in the Order Form given below

The cost of the full single-user version (Product Code RETCDDIS) is £52.81 
(£39.95 + £5 P&P + VAT).

Turnpike, August 1997
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T U R N P I K E   O R D E R   F O R M
** for non-Demon subscribers **

(Demon subscribers can buy at the special price of £29.37 - see above)

Yes, I'd like to order an Upgrade from the Evaluation version of Turnpike  (Product Code 
RETCDDIS) Price: £52.81

I require (tick one only) ____ CD ____ 3.5" disks for Windows 95

                     ____ 3.5" disks for Windows 3.x

Your details:

Name: _________________________________________________

Address: _________________________________________________

_________________________________________________

_________________________ Postcode: _______________

Phone no: _________________________________________________

Email
 address: _________________________________________________

Access
 provider: _________________________________________________

Modem: _________________________________________________
(Manufacturer and Model)

Payment details:   Amount payable  £52.81

I wish to pay by:

   ___ Cheque (payable to Demon PSD, enclosed herewith)

   ___ Credit Card    Access / Visa / Mastercard

                      account number _________________________________

                              expiry date _________________________________

                                 signature _________________________________

Date of order: ________________________________________________

VAT no., if applicable (EEC orders):

                _________   _______________________________________
                (country)                 (number)

Send your completed form to Demon PSD, P.O.Box 137, HORSHAM, West Sussex 
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RH13 5FH or fax it to 0345 666222

We aim to deliver within a week, but please allow up to 28 days for delivery.
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